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WHAT'S NEW IN HSC CHEMISTRY® 6.0 

 
Fig. 1. HSC Chemistry® 6.0 Main Menu. 

The old HSC Chemistry® 5.1 software is made for the simulation and modeling of single 
chemical reactions and unit processes. The new HSC Chemistry® 6.0 will expand the 
scope of the old HSC 5.1 software to include the simulation and modeling of the whole 
process, made up of several unit processes. HSC 6.0 also has many other new features: 

• The new Sim module with versatile auxiliary Data, Data-Fit and Geo modules. 
• Larger H, S and Cp database with more than 20000 species (HSC 5.1 has 17000 

species). Several other fixes has also been made to the database. 
• New Excel AddIn interface with better compability with different Excel versions and 

different computers. 
• New Excel AddIn functions like StreamEQ for equilibrium calculations. 
• The printing and copy-paste options of the HSC modules has been improved. 
• The compability with Windows XP has been improved with several code changes 

and a new installation routine. 
• Working demo of the new GPS based Material Map module. 
• Many other small bug fixes and new properties. 
• The familiar the HSC style, user interface and file formats have been maintained in 

order to minimize the training requirements for current HSC users. 

-  Optimize process output and minimize waste materials using the new HSC 6.0  - 
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New Sim Module 

 
Fig. 2. HSC-Sim Module user interface with drawing and run mode. 

The target has been to develop an easy-to-use simulation tool for many types of basic 
applications from chemical processes to economic optimization. HSC-Sim 6.0 has 
especially been tested with process metallurgical and mineralogical applications, but it 
may also be used in a wide range of other applications. 

The HSC-Sim user may start from a single chemical reaction and end up with the final 
process model. HSC-Sim is a simple but still powerful simulation tool for the ordinary 
process engineer. For the old HSC users with Excel spreadsheet skills it should be easy 
to learn to use the new Sim module. HSC-Sim flowsheet process is made of single 
process units which are connected with each others with streams. Behind each process 
unit there is "a small HSC engine" for thermochemical simulation models. 

The Sim module uses two main user interfaces: a graphical flowsheet interface and 
behind each process unit a spreadsheet type Model Editor interface. The basic ideas of 
the Sim module are quite simple: 
1. The process consists of the process units which have been connected to each other 
with streams. The flowsheet is saved in one FLS file. 
2. Behind each process unit there is a "small HSC engine" made of an Excel emulator 
with HSC AddIn functions or other DLL-based tools. Each unit has its own XLS file. 
3. The process unit calculation models are independent of each other. 
4. The streams on the graphical flowsheet specify the material and data transfer between 
the process units (FLS file). 
5. There are two modes in the HSC-Sim module: the Designer Mode and Run Mode. 
The user draws and edits the flowsheet in the Designer mode. In the Run (calculation) 
mode the graphical flowsheet is locked. 

 

-  Optimize process output and minimize waste materials using the new HSC 6.0  - 
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Fig. 3.  Some process examples. The Sim module development started some 4.5 years 
ago and  it has been tested with numerous new and old real process flowsheets. It has 
been used internally in Outokumpu Technology more than 2 years already. The flowsheet 
samples have been blurred due to confidentiality in this figure. 

-  Optimize process output and minimize waste materials using the new HSC 6.0  - 
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Mineral Based Models 

 

Fig. 4.  . Global and set-up for each input stream in Mineral Based models. 

HSC-Sim has a special set-up and approach for processes where minerals are treated. In 
the processes including crushing, grinding, flotation, gravity separation or screening this 
approach should be used. Particles with at least A) size (diameter) and B) mineral 
composition (wt-%) data can be handled in mineral-based models. 

In addition, they may have additional parameters like mineral volume-%, mineral area-% (on 
the surface of a particle), whiteness and hardness. Globally, minerals have a certain 
chemical composition and specific gravity and therefore HSC calculates these properties for 
each particle and also for each stream. Particles can be generated through mineralogical 
information. There are two levels of information required, Fig. 4. 

The HSC Geo module makes possible to calculate, for example, composition of the sulfide 
fraction and volatile-and-sulfide-free composition from chemical analysis of a rock certain 
petrochemical indices like CIPW norm. It includes mineralogical database of ca. 5500 
minerals and their chemical compositions. 

HSC Geo also contains a versatile tool for modal calculations, i.e. to convert chemical 
analysis to mineralogical composition. 

HSC Data is a general data processing tool with which you may use for statistical analysis, 
xy/ternary/spider diagram drawing, linear modeling and population analysis based on 
numerical data in normal Access database. 

 

 

 

-  Optimize process output and minimize waste materials using the new HSC 6.0  - 
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New Excel Add-In Functions 

 
 
Fig. 5.  New Stream Functions in AddInSample.xls. 
 
The HSC 6 Excel AddIn functions use the new HSC6.XLL interface instead of the old 
HSC5.XLA. This improves the compatibility with different Excel versions and makes 
possible easier file exchange within different computers. Several new AddIn functions 
have also be added which makes it possible to calculate stream properties, for example, 
in simulation models, Fig. 5. 

The new StreamEQ function enables the user to carry out equilibrium calculations in MS 
Excel, Fig. 6. The new DensityA function makes it possible to calculate the density of 
several aqueous solutions, etc. 
 
 

-  Optimize process output and minimize waste materials using the new HSC 6.0  - 
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-  Optimize process output and minimize waste materials using the new HSC 6.0  - 

 
Fig. 6.  New StreamEQ Function for equilibrium calculations. 

Other New Features 
The new Data, Data-Fit and Geo modules are useful tools when creating process models 
using HSC-Sim. However, these modules may also be used in many other applications. 
For example, the HSC-Sim Data-Fit module may be used to convert experimental data 
points into functions which can be used in the unit models, Fig. 7. 

 
Fig. 7.  New Data-Fit module. 

A working demo of the new GPS based Material Map module makes it possible to create 
location-based material maps. However, the plants and stocks are different, therefore, 
some tailoring and tuning is usually needed. Please ask for a quote for this work from 
Outokumpu Research Oy. 

The high quality thermochemical H, S and Cp data is needed in many process 
calculations. The HSC 6.0 extensive thermochemical database with more than 20000 
species is unique and valuable source for this basic data. This data is automatically used 
in all HSC calculation modules but it may also be used in other programs and as a quick 
reference on the available data sources. 
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8. INTRODUCTION 
 

HSC Chemistry is designed for many different kinds of chemical reactions and 
equilibrium calculations. The current version contains 14 calculation options for single 
process unit calculations: 

1. Reaction Equations 
2. Heat and Material Balances 
3. Heat Loss Calculations 
4. Equilibrium Compositions 
5. Electrochemical Cell Equilibria 
6. Formula Weights 
7. Phase Stability Diagrams (Tpp- and Lpp-versions) 
8. Eh - pH – Diagrams with concentration and temperature variables 
9. Enthalpy, entropy, heat capacity, Gibbs-energy and Ellingham diagrams. 
10. Mineralogy Iterations 
11. Composition conversions 
12. Water - Steam Tables and Mollier Diagrams 
13. Units Conversions 
14. Properties of Elements in tabular and graphical format. 
 
The HSC 6.0 contains also new flowsheet simulation module (Sim) for process calculation 
of the whole process made of several process units. The new modules (Geo, Data, Map) 
support process simulation calculations. 
 
The name of the program is based on the fact that all fourteen calculation options 
automatically utilize the same extensive thermochemical database which contains 
enthalpy (H), entropy (S) and heat capacity (Cp) data for more than 17000 chemical 
compounds. This database is equivalent to more than seventeen thick data books.  
 
The HSC Chemistry software enables the user to simulate chemical reactions and 
processes on the thermochemical basis. This method does not take into account all the 
necessary factors, such as rates of reactions, heat and mass transfer issues, etc. However, 
in many cases a pure thermochemical approach may easily give useful and versatile 
information for developing new chemical processes and improving the old ones. 
 
Perfect simulation for all processes means that any chemical process can be designed 
completely in the computer without any experimental work. This goal is, however, far in 
the future, because there is no complete general theory or basic data available which 
would successfully combine thermodynamics, non-ideality of solutions as well as 
dynamics (kinetics) for all processes. Nearly perfect simulation may be achieved for a 
single individual process step by measuring experimentally all the necessary parameters 
for solution models, kinetic models, as well as for flow and heat transfer models. 
However, this needs several months or years work to be able to simulate one single 
process step. Quite often a fast mainframe computer is needed. 
 
With HSC Chemistry it is possible to calculate chemical equilibria between pure 
substances and the ideal and also, to some extent, non-ideal solutions. For these 
calculations only enthalpy (H), entropy (S) and heat capacity (Cp) data for all prevailing 
compounds or pure substances is needed. In many cases these calculation results may 
simulate the real chemical reactions and processes at sufficient accuracy for the practical 
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applications. Important advantage is also that specification of the chemical system, data 
retrieval and final calculations may be carried out in normal Intel Pentium personal 
computers within few minutes. 
 
Of course, experimental work is needed to verify the results, because HSC does not take 
kinetic phenomena into account. However, HSC helps to avoid expensive trial-and-error 
chemistry, because it quickly and easily gives some kind of clue as to the effects of 
process parameters on the reaction products and process conditions. Usually, 
thermochemical calculations at least show what is physically possible and what is 
impossible, which is highly valuable information when making plans for experimental 
investigations. 
 
In the thermodynamic equilibrium the rates of reactions and reverse reactions may both be 
interpreted to have the same rate, ie. this state is only one special case of kinetic 
phenomena. Of course, some programs are available which also take some kinetic aspects 
into account. However, these are not general like thermodynamic equilibrium codes are, 
ie. they are usually valid only for certain geometries and environments. 

 
A number of solution models are available in literature to describe the non-ideality of 
mixture phases. The practical problem is quite often a lack of valid data for solution 
parameters. Although solution models have not been installed in the HSC Chemistry, the 
non-ideality of solutions can be taken into account in the equilibrium calculations to a 
certain extent by including constant activity coefficients or simple activity coefficient 
formulae in the Gibbs equilibrium solver. 

8.1  Invitation to new Authors 
 

If you have a thermochemical computer program or basic thermodynamic data which may 
be of more general interest, please send it to the author: 

 
Antti Roine 
Outokumpu Research Oy 
P.O. Box 60 
FIN-28101 PORI, FINLAND 
Fax: +358 - 2 - 626 - 5310 

 
We may also add your code to future versions of HSC Chemistry. Connection to the HSC-
database and fitting the code and user interface to HSC format can be carried out in 
Outokumpu Research. Integration is easiest if the original code is written in Visual Basic, 
QuickBASIC or BASIC. 

 
The new thermodynamic data which is saved in OwnDB5.HSC database can easily be 
transferred to MainDB5.HSC at Outokumpu Research. 
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8.2 Physical Background of H, S, C and G 
 

Thermochemical calculations are based on enthalpy H, entropy S, heat capacity Cp or 
Gibbs energy G values for chemical species. They can all be mathematically derived from 
experimental observations. The following presentation gives a brief and simplified but 
illustrative idea of the thermochemical quantities and methods. 

 

Enthalpy H: Absolute values of enthalpy H of substances cannot be measured, but 
enthalpy differences between two temperatures can be determined with a calorimeter. 
Heat capacity Cp at constant pressure (specific heat) can be calculated from this data using 
Eq. (1). 

 

Cp = (dH / dT)P,n   [1] 
 

Equation (1) allows the calculation of enthalpy as 
 

T 
H(T) =  Hf(298.15)+      ∫ Cp  dT   +   Σ Htr   [2] 

298.15 
 

where Hf(298.15) is the enthalpy of formation at 298.15 K and Htr is the enthalpy of 
transformation of the substance. Calorimetric measurements at different temperatures 
yield the enthalpy curve of zinc shown in Fig. 2. 

 

The enthalpy scale in Eq. 2 is fixed by defining H = 0 for the elements in their most 
stable state at 25 °C and 1 bar, mainly because this is convenient for calculations at 
elevated temperatures. This is called the reference state. (Another fix point could have 
been H = 0 at 0 K, because the thermal motion of atoms and electrons stops completely at 
this temperature.) 

 

The ability of a chemical substance to absorb or emit heat depends on the temperature, and 
therefore the curve in Fig. 2 is not linear. In addition, at phase transformation temperatures 
the curve is discontinuous, because heat is needed for the phase transformations (ie. for 
crystal structure changes, as well as for melting and boiling). 

 

The enthalpy of compounds also contains their enthalpy of formation DHf from 
elements. This is usually measured calorimetrically by letting pure constituent elements 
react and form the compound at 298.15 K and 1 bar. The enthalpy of the compound is 
therefore calculated by adding the enthalpy of formation to the experimental enthalpy 
difference H(T)-H(298), see the solid line in Fig. 3. 

 

The enthalpy values of gaseous zinc can be extrapolated to lower temperatures as shown 
in Fig. 2 by the dotted line. The reference state for zinc at 25 °C and 1 bar is hexagonal 
crystal. The enthalpy of gaseous zinc is 130.415 kJ/mol larger compared to solid pure zinc 
at 298.15 K. This amount of heat is needed to evaporate one mole of zinc at 25 °C and 1 
bar, and is called the enthalpy of formation of zinc gas from solid zinc. 
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Entropy S: Abs
Equation (3) an
 

T 
S = S(298.15)   +      ∫ (Cp / T) dT  +   Σ Htr / Ttr  [3] 

298.15 
 

where S(298.15) is the standard entropy of the substance which can be calculated by 
integrating Cp/T function from 0 to 298.15 Kelvins, T is temperature and Htr is enthalpy 
of phase transformation at a temperature Ttr, see Fig. 4. 
 
Entropies of crystalline substances approach zero at 0 K. This fundamental experimental 
observation is compatible with the third law of thermodynamics. If entropy is understood 
as a measure of disorder, the disorder reaches its minimum at absolute zero and in perfect 
crystal structures. 

 
Heat Capacity Cp: The absolute heat capacity of substances at constant pressure can be 
calculated as a first derivative of the enthalpy curve in Fig. 2, using Equation (1). The heat 
capacity curve is discontinuous at phase transformation temperatures, see Fig. 5. The heat 
capacity values of crystalline substances in equilibrium approaches zero value at 0 K. 
 
The temperature dependence of heat capacity at elevated temperatures cannot be predicted 
theoretically by thermodynamics. A fully mathematical correlation is therefore adopted 
for fitting experimental heat capacities. The Kelley equation is used throughout this 
program in the following form: 

 

Cp  = A + B . 10-3 . T + C . 105 . T-2 + D . 10-6 . T2  [4] 
 

where A, B, C and D are coefficients estimated from experimental data. 
 

Gibbs Energy G: The mutual stability of substances (elements, compounds, ions, etc.) 
cannot be compared using enthalpy, entropy or heat capacity functions solely. It must be 
done using the Gibbs energy defined by Equation (5). The Gibbs energy of pure zinc has 
been calculated using this equation and data in Figs. 2 and 4. The results can be seen in 
Fig. 6. 

 

G = H - T . S    [5] 
 

Experimental Methods: Many experimental and theoretical methods are available for 
evaluating the basic thermochemical enthalpy, entropy and heat capacity data than it is 
practical to describe in this context. Usually a critical analysis of the values is based on a 
thorough simultaneous cross-correlation of thermochemical data from different sources, 
measurement methods (calorimetric, spectroscopic, electromotive force, solubility, etc.) 
and theoretical calculations. More information of the assessment methods can be found, 
for example, in the references mentioned in Chapters 32 and 33. 

olute entropy values can be calculated from the experimental heat capacity values using 
d numerical integration.  
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Fig. 4. Entropy of zinc calculated from the experimental heat capacity, by Eq. (3). 
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Fig. 6. Gibbs energy of zinc at 0 - 1400 K calculated from the enthalpy and entropy values using Equation 
(5). 

Databases: Traditionally, experimental heat capacity values - 
e Fig. 5 - have been fitted using the empirical Equation (4). The coefficients A, B, C and 

D provided in HSC are valid in limited temperature ranges only. Usually the temperature 
 

 
transformation as well as the coefficients for the second temperature range, etc. For 

been derived from the experimental heat capacity 
values, Fig. 5, using curve fitting and Equation (4), see Chapter 28.12. 

Note that the data for gaseous substances as Zn(g) has been saved separately. Such a 

below their boiling points. 

Data Format in the HSC 
se

ranges are the same as the stability ranges of solid, liquid and gaseous states of the
substances. 

The heat capacity coefficients can be saved in the HSC database as data sets for each 

The second set contains the enthalpy and entropy of

temperature range, together with the enthalpy and entropy values for formation and 
transformations. The first data set contains the enthalpy of the formation Hf(298.15), 
standard entropy S° and the coefficients A, B, C and D for the most stable form of the 
substance at room temperature. 

further details, see Chapter 28.11. 

Table 1 shows the thermochemical data of zinc as printed from the HSC main database. 
The same enthalpy values can be found in Fig. 2, as well as the entropy values in Fig. 4. 
The coefficients A, B, C and D have 

selection allows, for example, equilibrium calculations with the gaseous substances also 
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Species State Enthalpy Entropy  Heat Capacity Cp  Temperature Range
T2

kJ/mol J/(mol*K)   J/(mol*K)  K  K

4
0  1180.000 

 2000.000 

H S A B C D T1

Zn s 0.000 1.631 20.736 12.510 0.833 0.000 298.150 692.655 
Zn l 7.322 10.571 31.380 0. 00 0.000 0.000 692.655

Zn(g) g 130.415 160.984 20.786 0.000 0.000 0.000 298.150
 

 
data se.

 
odules, including heat capacity, 

es, can be calculated from the  
C Che istry utilizes the equations 

 
d Gibbs energy functions 

 a c mic the products and reactants, 
an be calculated 

 values will be described 
0.4. 

 
Chemical reaction:  aA + bB +...  =  cC + dD +...  [6] 

 
Enthalpy of reaction:  ∆Hr ΣνiHi(Products)  -  ΣνiHi(Reactants) [7] 

 
     = (c*HC + d*HD +...) - (a*HA + b*HB +...) 

 
Entropy of reaction:  ∆Sr  ΣνiSi(Products)  -  ΣνiSi(Reactants) [8] 

 
     = (c*SC + d*SD +...) - (a*SA + b*SB +...) 

 
Gibbs energy of reaction: ∆Gr SniGi(Products)  -  ΣνiGi(Reactants) [9] 

 
     = (c*GC + d*GD +...) - (a*GA + b*GB +...) 

 
      [C]c * [D]d * ... 
Equilibrium constant:  K  =     [10] 
     [A]a * [B]b * ... 

 
     ln K = ∆Gr / (-RT)   [11] 

 
where the following abbreviations have been used: 
[A]  = activity or partial pressure of species A, B, C, etc. 
a = stoichiometric coefficient of species A in reaction 
ν = stoichiometric coefficient of a species in reaction (a, b, c, ...) 
R = gas constant = 1.987 cal/(Kmol)  =  8.314 J/(Kmol) 
T = Temperature in K 

Table 1. Thermochemical of zinc as printed from the HSC databa  

All thermochemical data required in HSC and its m
enthalpy, entropy and Gibbs energy of the substanc  basic
data in its databases using Equations (1)-(11). HS m
automatically whenever needed. 

Chemical Reactions: The thermodynamic enthalpy, entropy an
for he al reaction are calculated as the difference between 
using Equations (6) - (9). The commonly needed equilibrium constant K c
using Equation (11). The physical meaning of these functions and
in more detail in Chapters 10.1 - 1
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9. OPERATING INSTRUCTIONS 

9.1 Starting HSC  
 

The easiest way to start HSC Chemistry is by double-clicking the HSC icon in the 
Windows Program Manager using the mouse. Within a few seconds the computer loads 
HSC into the memory and displays the Main Menu of HSC on the screen, see Fig. 1. 

9.2 Main Menu of HSC 

 

Fig. 1. The Main Menu of HSC Chemistry. 
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The current version of HSC has fourteen calculation modules as well as element and 
species databases, which can be seen as option buttons in the main menu, see Fig. 1. The 
option is selected by clicking the button by mouse or using the Tab and Enter keys. 

All the calculation options have various printing facilities for tables and diagrams with a 
formatting possibility. However, some options use the default printer font settings, which 
can be selected, for example, by pressing Settings in the main menu, see Fig. 1. For a 
description of Help see Chapter 9.4. 
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9.3 Printer Settings 
 

 
Fig. 2. Selecting fonts for tables and diagrams. 

 
Font settings are available for tables and diagrams separately, however only one font type 
and size can be selected at a time. After pressing Settings in the main menu, Fig. 1, the 
program shows the HSC Printer Settings Window, Fig. 2. Please use the following steps 
to select fonts: 

 
1. Press Font in the Table Font group. 
2. Select Font type from the list. 

A non-proportional font is recommended for the tables, for example: LinePrinter, 
Courier New and Courier. 

3. Select the Font size and style (regular, bold), recommended size is 8 - 12. 
4. Press Font in the Diagram Font group. 
5. Select Font type from the list, non-proportional and proportional fonts can be used. 
6. Select the Font size and style (regular, bold), recommended size is 10 - 12. 
7. Change the Top and Left Marginal settings if necessary. 

 
A sample of the font is available in the Settings Window at all times. By pressing the OK 
button the selected fonts and sizes will be saved in the HSC6.INI file in your Windows 
directory. HSC6.INI can also be edited using for example the Notepad ASCII-editor. 
HSC always reads the HSC.INI file first when starting, therefore the last specified font 
settings will be used. See Chapter 7.3. for a description of the HSC6.INI file. 

 
To return to the main menu, click on Cancel. The default printer settings can be changed 
using the Printers icon on the Control Panel. 
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9.4 Using HSC Help 
 
The new HSC Help module contains all the information, graphics and formulae of the 
HSC printed manual along with convenient search, print, edit and save options. The 
"Help Manual" is divided into 34 chapters all being separate files. These files are in Word 
2000 format and located in the HSC6\Help-folder. 
 
Nearly all HSC menus have a Help selection that opens the HSCHelp module and 
displays the corresponding chapter in the manual. Fig. 3 shows the help pages for Chapter 
10. Reaction Equations. 
 

 
Fig. 3. HSCHelp module with the Reaction Equations module selected, see Fig. 1 in Chapter 10. 
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The left frame lists all the available help chapters and the right frame displays the current 
selection. Clicking on a chapter in the left frame will automatically load and show that 
chapter in the right frame. To print the current chapter, select File/Print from the menu.  

It is also possible to search the manual using keywords. Simply select the Search tab 
from the left frame and type the desired keyword in the textbox. By pressing the List 
Topics button all the chapters containing the keyword are displayed. The desired chapter 
may then be selected and by pressing the Find Next button, the next entry containing the 
keyword is displayed. Fig. 4 shows a search conducted using the keyword “stream”.    

 

 
Fig. 4. Search the manual using keywords. 
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The HSCHelp Editor enables the user to manually view and edit help chapters. Select 
Edit/Edit Current Document from the menu to open the editor for the current chapter. 
The edit mode can be useful when, for example, printing only a few pages or a selected 
part of a chapter. Several of the typical word processing options are available in the Help 
Editor. HSC Help Editor reads and writes Word 2000 files and it supports most of the 
Word 2000 features but not all, i.e. it is not 100% Word 2000 compatible. Fig. 5 shows 
the edit mode for Chapter 11. Heat and Material Balance.  

Note that you may also add your own DOC-files to HSC6\Help-folder and HSCHelp-
routine reads these automatically. 
 

 
Fig. 5. HSCHelp, Edit Mode. 
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10. REACTION EQUATIONS  
Clicking the Reaction Equations button in the main menu shows the Reaction Equations 
Window, see Fig. 1. With this calculation option you can calculate the heat capacity, 
enthalpy, entropy and Gibbs energy values of a single species as well as of specified 
reactions between pure substances. 

See the reference state definitions, valid notations and abbreviations for the description of 
the chemical formulae in Chapter 28. Databases, chapter 2. 

10.1 One Chemical Substance 
 

 
 
Fig. 1. Reaction Equations Window of HSC Chemistry. 
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Fig. 2. Thermodynamic data of A12O3 (alumina) displayed by the Reaction Equation option of HSC 
Chemistry. 

 
By entering a single chemical formula into the Formula box you will get similar tables of 
thermochemical data as presented in many thermochemical data books. HSC will, 
however, provide the results faster and exactly at those temperatures which you really 
want. Please follow these steps: 
1. Write a chemical formula into the box, Fig. 1. 

For example: Fe, Na2SO4, Al2O3, SO4(-a), H(+a) or SO2(g). 
See the valid notation and syntax of chemical formulae in Chapter 21.2. 

2. Select the lower limit, upper limit and temperature step. 

3. Select the Temperature and Energy Units, by clicking the corresponding buttons. 

4. Select the Format of the results. 

Normal (Absolute scale): 

H(species), S(species) and C(species) 

This format is used for example in the famous I. Barin, O. Knacke, and O. 
Kubaschewski data compilation1. 

 

Delta (Formation functions): 
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∆H = H(species) - ΣH(elements) 

∆S = S(species) - ΣS(elements) 

∆G = G(species) - ΣG(elements)  

∆G = G(ions) - ΣG(elements) + z/2*G(H2(g)) - z*G(H(+a)) 
z = charge. 

This format is used for example in the NBS TablesNBS 82. 

5. The Collect to Sheet option will collect several tables on the same spreadsheet. 

6. Select the Show Transitions option if you also want to see the data at the phase 
transformation temperatures, such as crystal structure changes and melting. 

7. Select the Criss-Cobble option if you want a Criss-Cobble extrapolation for the 
heat capacity of aqueous species, see Chapter 21.4. 

8. Press Calculate (or Enter) to get the results on the screen. 

9. Press Print to print the results, see Fig. 2. Note that you can collect several sets of 
results in the same sheet if you have selected the Collect to Sheet option in Fig. 1. 
You can clear the whole sheet by pressing Clear. 

10. Press Copy All to get all the results into the Clipboard, then you can easily paste the 
results to other Windows applications, for example, to MS-Excel, see Fig. 2. Using 
Copy it is possible to copy and paste contents of individual cells to other 
applications. 

11. If you want to save the formula and results in an ASCII-file press Save, see Fig. 2. 
You can read these files back to the Reaction module using File Open, see Fig. 1. 
Note that Save saves all the selections in Fig. 1, so you can return these using File 
Open. The File Open HSC 2 File button reads only old HSC 2.0 files which return 
only formula, but not the selections nor temperature range. 

Note: 1. You can easily check the basic data from the database, which has been used in the 
reaction module calculations. In Fig. 1 select the formula in the Reaction Equation 
box and press Peep Database. The same procedure can be found in Fig. 2 by 
pressing the right mouse button or selecting Edit from the menu. 

2. The table in Fig. 2 has some formatting and Copy - Paste functions as do other 
tables in HSC Chemistry. These features help to create a good printed copy of the 
results for various purposes. 

3. HSC searches for the species data first from the Own database (OwnDB5.HSC). If 
it does not find a species there, it will search from the Main database 
(MainDB5.HSC). Therefore HSC always uses data in the Own database if the same 
species exists in both Own and Main databases. 

4. If you have selected Delta-format for the results, HSC will also search for data for 
the necessary elements and calculate the formation functions of enthalpy, entropy 
and Gibbs energy. Usually the original experimental data is in this format: however, 
sometimes the comparison of data in this format may be more difficult because the 
data sources often use different data for elements. 

5. HSC will make a Criss-Cobble extrapolation for the heat capacity of aqueous 
species at elevated temperatures (> 25 C°) if the Criss-Cobble option is selected. 
The extrapolation is not done if A and B of the heat capacity coefficients A, B, C 



      HSC Chemistry® 6.0   10 - 4 
 

Antti Roine     August 10, 2006     06120-ORC-T 

and D exist in the HSC Chemistry databases. The extrapolation error increases 
rapidly at higher temperatures. More information on extrapolation is given in 
Chapter 28.4. 

6. For aqueous species it is recommended to set: 
Lower temperature  = 25 °C 
Upper temperature  = 300 °C 
Step    = 25 °C 

10.2 One Chemical Substance Results 
 

After pressing the Calculate button in the previous screen, Fig. 1, you will arrive in the 
results window, Fig. 2. From this results screen you can save and print the results: 

1. Press Save if you wish to recalculate the results later. The Save button will also 
save the settings used in Fig. 1. You can read these files back to HSC using the File 
Open button, see Fig. 1. 

2. Press Print if you want a paper copy. If you have selected the Collect to Sheet 
option in Fig. 1, then all results will be collected on the same sheet and can be 
printed together. Clear will clear the results sheet. 

3. Press Copy to get the results of selected cells into the Clipboard, then you can 
easily paste the results, for example, to MS -Excel, see Fig. 2. 

4. Press Copy All to get all the results of the sheet into the Clipboard, then you can 
easily paste the results, for example, to MS -Excel, see Fig. 2. 

5. Press OK to return to the previous Window. 
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10.3 Reaction Equations 
 

 
 
Fig. 3. Input data for Reaction Equation calculations. 
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Fig. 4. Results of Reaction Equation calculations. 
 

You can write almost any kind of reaction equation into the Reaction Equation box of 
HSC, Fig. 3. Here are some examples of valid equation syntax: 

 
2Cu + S = Cu2S 
H2O = H(+a) + OH(-a) 
H2(g) = 2H(+a) + 2e- 
H2O = 1/2O2(g) + 2H(+a) + 2e- 
Ag = Ag(+a) + e- 
3NO2(-a) + 2H(+a) = 2NO(g) + H2O + NO3(-a) 
2Al(+3a) + 3S(-2a) + 6H2O = 2Al(OH)3 + 3H2S(g) 
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Write the reaction equation into the box, see Fig. 3. If you have not given the 
stoichiometric coefficients for the species, you can press Balance Equation for solving 
unknown coefficients. The balance button solves the coefficients on the basis of element 
balance equations. Therefore it cannot solve unknown coefficients if their number is larger 
than the number of elements in the corresponding reaction. 

 
On the right side of the button you may give a multiplier, which will be used to multiply 
all the coefficients in the reaction equation. The default value is 1, which means that the 
smallest stoichiometric coefficient in the reaction equation is 1. 

 
You can continue in the same way as in the One Chemical Formula option Chapter 10.1. 
Note that the Delta Format and Show Transitions options have no effect on the results, 
because the enthalpy and Gibbs energy of a reaction are in the Delta format by definition. 
 
HSC calculates the stoichiometry of the reaction given by the user, and points out errors if 
the element balance is incorrect. 

 
The example in Fig. 3 refers to the Mond-process for refining impure nickel. In the 
process raw impure nickel is first treated with CO gas at 60 °C to evaporate the nickel as a 
carbonyl gas. In the second stage, the temperature of the gas is increased to 200 °C to 
decompose the nickel carbonyl gas into pure metallic nickel and CO. This process works 
because the equilibrium of this reaction is on the right side (Equilibrium constant K > 1) at 
lower temperatures and on the left side (K < 1) at higher temperatures. The reaction is 
exothermic (DH is negative) at all temperatures. 

 
Vapor pressures p can be calculated by writing the reaction equation for the vaporization 
reaction concerned. For example, for pure magnesium the equilibrium is Mg = Mg(g), Fig. 
5. The activity a of pure magnesium is 1 and thus the vapor pressure in bar is equal to the 
equilibrium constant according to Eq. (10) in Chapter  8. Introduction and Eq. (1). See 
also Fig. 6. 

 
K  =  pMg / aMg  =  pMg   [1] 

 
If a substance vaporizes into several polymers, all of them must be taken into account. The 
total vapor pressure is then the sum of all the individual partial pressures, if the gas phase 
behaves ideally. 

 
You can also calculate more complicated reactions. First write the reaction as shown in 
Fig. 7, then press Balance for the coefficients, see Fig. 8 and finally press Calculate for 
the results, see Fig. 9. Note that for aqueous ionic reactions HSC also calculates the 
electrode potential versus Standard Hydrogen Electrode if electron (e-) is used in the 
formula. 

 
You can calculate mass balances in moles, grams and liters for any reaction. The species 
does not need to exist in the HSC databases. 

 



      HSC Chemistry® 6.0   10 - 8 
 

Antti Roine     August 10, 2006     06120-ORC-T 

 

 
 
Fig. 5. Input data for Reaction Equation calculations. 
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Fig. 6. The equilibrium constant K is equal to the vapor pressure in atm according to Equation (1) if the 
activity of magnesium is 1. The boiling point of magnesium is about 1100 °C beyond which its vapor 
pressure exceeds 1 atm. 
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Fig. 7. Write the reaction equation without stoichiometric coefficients and press Balance Equation. 
 

 
Fig. 8. Press Calculate to display the results. 



      HSC Chemistry® 6.0   10 - 11 
 

Antti Roine     August 10, 2006     06120-ORC-T 

 
Fig. 9. Results for an aqueous ionic reaction. 

 
The data used to calculate the results can be displayed by selecting one substance in the 
Reaction Equation box, see Fig. 3 and pressing Peep Database. The same procedure can 
be found in the Results window, see Fig. 4, by pressing the right mouse button. The 
database content is shown in Fig. 10. Insert is available for inserting a selected formula 
into the Reaction Equation box. Remove will remove a selected formula from this same 
box. Note that the selections and editing in Fig. 10 do not have any effect on the HSC 
databases. 
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Fig. 10. The database window. 
 

10.4 Reaction Equations Results 
 

The operation of the buttons in Fig. 3 are described in the previous chapter. The meaning 
of the results can be summarized as the following: 

1. If the equilibrium constant K is < 1 (or log(K) < 0) the reaction goes to the left. 

2. If the equilibrium constant K is > 1 (or log(K) > 0) the reaction goes to the right. 

3. Negative Enthalpy H of the reaction means that the reaction is exothermic, i.e. heat 
is released, Equation 7 in 8. Introduction. 

4. Positive Enthalpy H of the reaction means that the reaction is endothermic, i.e. heat 
is needed, Equation 7 in 8. Introduction. 

5. Delta Format has no effect on the results of reaction equations. 

6. In ionic reactions POTENTIAL E yields the electrochemical potential (in Volts) 
versus the Standard Hydrogen Electrode. 

7. Equilibrium constant K is calculated using Equation 11 in 8. Introduction. 
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11. HEAT AND MATERIAL BALANCE 
 

 
 
Fig. 1. Heat and Material Balance workbook with IN1, OUT1 and BAL sheets.  

Heat balance calculations are usually carried out when developing new chemical 
processes and improving old ones, because no process can work if too much heat is 
released or if there is a lack of thermal energy to maintain the reaction temperature. This 
module calculates the real or constrained heat balances, with given mass-balances as the 
boundary conditions, but not the theoretical balances at equilibrium conditions. 

The heat balance application always contains IN1, OUT1 and BAL sheets. A pair of IN 
and OUT sheets is called a Balance area, which may be considered equivalent to a 
control volume. A total number of 127 balance areas may be inserted, to create a multiple 
balance area workbook. Multiple balance area workbooks are explained in more detail in 
chapter 10. Multiple balance areas. For simplicity only the first balance area (IN1, 
OUT1) will be described in the following chapters. 

The basic idea of the heat balance module is that the user specifies the IN1 and OUT1 
species, temperatures and amounts and the Heat Balance module automatically calculates 
the heat and material balances using the BAL sheet. The Heat balance module updates the 
calculated results on the BALANCE row at the bottom of the form each time the user 
changes the input data. Please do not modify the BAL sheet.  
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Since the program uses and creates new balance areas according to the name of the 
sheets, it is extremely important that the automatically created sheet names, i.e. the BAL, 
INx and OUTx sheets, should not be modified. 

You can also add new sheets for other spreadsheet calculations using the Insert Sheet 
and Insert Excel Sheet selections in the menu. The other sheets work very much like MS 
Excel worksheets, for example, you can: 

- rename the sheet name by double clicking the sheet tab 
- type formulae into the cells 
- use similar cell references as in Excel 
- use most of the Excel functions 
- link the sheet to IN1 sheet using normal Excel cell references, for example, for 

converting elemental analysis of the raw material to amounts of the components. 
- use the heat balance calculation results in OUT1 sheet as the initial values for other 

spreadsheet calculations. 
 

In addition the Heat Balance menu provides a wide range of Excel type features, such as: 
number, font, alignment and border formatting, defined names settings and cell 
protection. Because they are not necessarily needed in heat balance calculations, these 
features are not described here in detail. 

The new heat balance module offers several ways to calculate heat and material balances: 

1. The user types the input and output species, temperatures and amounts into the IN1 
and OUT1 sheets respectively. This is a simple way to calculate heat and material 
balances and was available already in HSC 2.0. However, the problem with the old 
version was that the user had to manually maintain the material balance when the 
input feed changed. 

2. Materials (species) are given as groups of substances, called streams. These 
streams can be the same as the phases, but they can also be a mixture of phases. 

3. The output amounts can be linked with the input amounts with Excel type cell 
references, or vice versa. 

11.1 Basic Calculation Procedure 
 

The following procedure will describe the most simple way to calculate Heat Balance: 
1. Introduce the input substances (raw materials), temperatures and amounts on the 

IN1 sheet. It is possible to either type amounts in kmol, kg or Nm3. It is advised to 
use kmol and kg because missing density data may cause inaccuracy with Nm3 
units. 

2. Introduce the output substances (products), temperatures and amounts on the OUT1 
sheet. Type amounts in either kmol, kg or Nm3 as preferred. 

3. When feeding additional energy (electricity) to the process, enter this amount into 
the Total column in the last empty row of the IN1 sheet. You can also type for 
example “Extra Heat” in the first column of this row, see Fig. 20. The Database 
module will convert the color of all “inert“ text in the first column to green, if this 
text is not identified in the database as a substance. Notice that: 

1 kWh = 3.6 MJ = 0.8604 Mcal (th). 

 However, the Balance module will automatically recalculate green text when 
changing units from the menu. If the green text cell contains a formula, it will 
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automatically be changed according to the new unit. For example a change from 
°C to K will add “+ 273.15” to the end of the formula. 

4. If heat loss values are known then type them into the last empty row of the OUT1 
sheet in the last column (Total). A first estimate of heat losses for an air-cooled 
reactor (natural convection) can easily be calculated using the following formula in 
kcal/h: 

 
Hloss = (6.8 + 0.046 * T2) * (T2 - T1) * A   [1] 

 

Where: A   = Outer surface area of the reactor (m2) 
T2 = Surface temperature of the reactor (°C) 
T1  = Room temperature (°C) 
 

 Please use the Heat Loss module if more accurate heat loss approximations are 
needed. 

5. HSC automatically and immediately updates the heat balance on the bottom line as 
soon as changes to any input data are made. 

6. HSC also automatically updates the material amount balances in mol, kg and Nm3 
units. Notice that only the mass balance in kg units on the bottom row should be 
zero; the mole or volume balances can easily change in any chemical process. 

7. The element balance can be checked by selecting Element Balance from the 
Calculate menu, see Figs. 1 and 2. 

8. By selecting Temperature Balance from the Calculate menu it is possible to see 
the estimated temperature of the products when the heat balance = 0, see Figs. 1 
and 3. 

 

 
 
  Fig. 2. Element Balance. 
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  Fig. 3. Temperature of the products (adiabatic process). 

9. To insert an empty row in the table, select Row from the Insert menu or by 
pressing the right mouse button and selecting Insert Row from the popup menu. 

10. Rows can be deleted by selecting Row from the Delete menu or pressing the right 
mouse button and selecting Del Row from the popup menu. 

11. You can change the order of the substances by inserting an empty row and using 
the Copy - Paste method to insert the substance in the new row. The Drag and Drop 
method can also be used. However, it is extremely important to Copy and Paste 
the whole row not only the formula, because of auxiliary data in the hidden 
columns on the right side of the IN1 and OUT1 sheets. 
Please keep the Copy Mode selection on in the Edit menu when rearranging the 
species, as this will force the program to select the whole row. When formatting the 
columns and cells, turn the Copy Mode selection off in the Edit menu. 

12. Temperature units can be changed by selecting the C or K from the Units menu. 
13. Energy units can be changed by selecting Mcal, MJ or kWh from the Units menu. 
14. If a paper copy is needed, select Print from the File menu. This option will copy 

all the data on the same Print sheet and will also print this sheet on paper if the user 
presses OK. Notice that you can delete this Print sheet by activating it and then 
selecting Sheet from the Delete menu. The Print Sheet selection in the File menu 
will print only the active sheet. 

15. To save the sheets, select Save from the File menu. Please save sheets often using 
different names, because you may wish to make small changes later or to return to 
the original sheet. Saving sheets is important, because the Undo feature is not 
available in HSC Chemistry. 

16. It is possible to take into account the water/steam pressure compensation by 
moving the cursor to an H2O or H2O(g) species and selecting Insert/Pressure 
correction H2O from the menu. This will open the Pressure and Temperature 
calculator, where it is possible to specify the pressure for the species. This is useful 
when calculating for example steam processes. 

11.2 Formatting the Worksheet 
The heat balance module offers several Excel type formatting possibilities. These may be 
selected in the Format menu: 
- Number, Font, Font Default, Alignment, Border, Pattern, Object (for graphical 

objects), Sheet, Options 
- Column Width, Row Height 
- Define Names, Refresh Names 
- Protection On, Off, Lock all Cells, Unlock all Cells 
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The window size may also be changed from the View menu. The Normal selection gives 
a VGA size window, Full Height selection uses the whole height of the screen and Full 
Width fills the whole screen. 

11.3 Specification of Substance Groups (Streams) 
The new HSC Chemistry 5.0 offers the possibility to specify the input and output 
substances in streams. These streams can be made of one or several physical phases or 
species which have the same fixed temperature and elemental composition. Although heat 
and material balance calculations can be made without using the streams, division into 
streams helps considerably when changing temperatures and material amounts. Notice 
that when using formulae/links in temperature cells the temperature cells are not updated 
if the species are not divided into streams. 

Examples of “one-phase streams” are, for example: 

1. Air feed. 
2. Process gas output. 
3. Homogenous liquid and solid inputs and outputs. 

Examples of “multi-phase streams” are, for example: 

1. Liquid material with solid particles (suspension) as input or output. 
2. Solid feed mixture of the process, made of different substances, such as mineral 

concentrate, coal and sand. 
3. Gas feed with liquid droplets or solid powder. 

The species rows in the IN1 and OUT1 sheets are divided into separate groups by special 
stream rows. These rows can be inserted in the sheet using the Stream selection in the 
Insert menu or using the same selection in the popup menu from the right mouse button. 

The heat balance module automatically makes the following modifications to the sheet 
when you insert a new stream (group) row in the sheet: 

1. Asks for a name for the new group, which you can change later if necessary. 
2. Inserts a new empty row above the selected cell with a light blue pattern. 
3. HSC assumes that all rows under the new group row will belong to the new group 

down to the next group row. 
4. Inserts Excel type SUM formulae in the new group row for calculating the total 

amount in the group using kmol, kg and Nm3 units. 

Once the insert procedure is ready, you can edit the group row in the following way: 

1. The stream name (label) can be edited directly in the cell. 
2. The stream temperature can also be changed directly in the cell and will affect the 

temperature of all the species in this group. 
3. The total material amount of the group can be changed simply by typing a new 

amount in the group row in kmol, kg or Nm3 units. This amount can be typed 
directly over the SUM formula and the program will automatically change the 
amounts of the species keeping the overall composition constant. The program will 
then regenerate the original SUM formula after calculating the new amounts. 

4. It is important to note that you are unable to type formulae in the amount and 
enthalpy columns of the stream row, because the SUM formulae must be in the 
stream row. 
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To change the amounts of species in a stream using kmol, kg or Nm3 units, simply type 
the new amount in the corresponding cell. The program will automatically update the 
amounts in the other columns, total amount of the stream and the total material and heat 
balance as well.  
An example of the species streams can be seen in Fig. 4. The output species have been 
divided into four streams. In this example the species in each stream exist in the same 
phase.  Process Gas is a gaseous mixture phase, Slag is a molten mixture phase and 
White Metal is a pure molten substance. 

 
 
Fig. 4. The OUT1 sheet of the Heat Balance module. The species have been divided into three streams, 
which are the same as the existing phases. 
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11.4 Formulae in the Cells 
 

Excel-type formulae and cell references can be used, for example, in order to link the 
input and output amounts with each other and to maintain the material balance 
automatically when the input amounts change. The input and output amounts can be 
linked using two main methods: 

1. An Excel-type formula can be typed in the kmol column, which expresses the 
dependence of the output mole amount on the input mole amount. For example, if 
Cu2S in the cell OUT1!C10 contains 93.8 % of copper input then you may type 
formula  = 0.938*IN1!C7 in cell OUT1!C10, see Fig 5.  

2. The Heat balance module automatically calculates input and output mole amounts 
for elements. The cell names for input amounts are: InAc, InAg, InAl, InAm and 
the equivalent for output elements are called OutAc, OutAg, OutAl, OutAm, etc. 
For balance areas with a higher number (for example the IN2 and OUT2 sheets) the 
corresponding cell names are simply  InAc2, InAc3 and  OutAc2, OutAc3, etc. 
These names can be used in the formulae. The formula in the previous example can 
also be written: =0.938*(InCu-C12)/2 using these defined names, see Fig. 5. The 
cells with element amounts are not visible to the user. 

Please be very careful when using default input and output names simultaneously, 
because it is very easy to end up with circular references. An indication of a 
circular reference is that the heat and material balance, which can be seen on the 
BALANCE row, changes even after a recalculation (Calculate/ReCalc from the 
menu). By selecting Format/Options from the menu and highlighting the 
Iteration checkbox under the Calculation tab, it is possible to automatically iterate 
the circular references. This is, however, not recommended for very large 
worksheets. 

Within the IN1 and OUT1 sheets it is recommended to use formulae only in the kmol 
column and not in the other Amount columns. You can use the formulae also in other 
columns, but please be very careful. In the other sheets there are no special limitations for 
the formulae. 
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Fig. 5. The OUT1 sheet of the Heat Balance module. Copper output has been linked with copper input 
with a formula and defined name: InCu. 
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11.5 Elemental Compositions 
 

The elemental compositions of the species groups may be calculated using the Stream 
Compositions selection in the Calculate menu, see Fig. 6. This procedure calculates the 
elemental compositions of each group, creates new In1-% and Out1-% sheets and prints 
results on these new sheets in mol-% and wt-% units. 
 
Notice that a procedure to convert elemental analysis back to species analysis is not yet 
available in the heat balance module. A general solution to this kind of problem is quite 
difficult and in many cases impossible. However, a custom-made solution for an 
individual case is possible with a little effort and normal Excel-type formulae: 

1. Create a new sheet using the Sheet selection in the Insert menu, see Fig. 6. 

2. Rename the new sheet by double clicking the tab, for example to “Compositions”. 
Notice that you can use also the Input-% sheet as the starting point as you rename 
it. 

3. Type the elemental and species compositions on the new sheet. 

4. Notice that you can insert Formula Weights in this new sheet by selecting the 
chemical formula cells and then selecting Mol Weight from the Insert menu. 

5. Create Excel-type formulae, which convert the elemental analysis of a group to 
mole amounts of species using formula weights of the elements and species. 

6. Type formulae in the kmol columns of the IN1 sheet, which refer to species 
amounts in the Compositions sheet. 
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Fig. 6. The Out1-% sheet of the Heat Balance module. This sheet shows the elemental compositions of 
the phases, after the Stream Compositions option has been selected from the Calculate menu. 
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11.6  Additional Sheets 
The Heat Balance workbook consists at least of the IN1, OUT1 and BAL sheets. The user 
may, however, add up to 256 sheets to one workbook. These additional sheets may be 
used, for example, to convert the elemental compositions of raw materials to amounts of 
species which are needed in the IN1 sheet. These sheets can also be used to collect the 
main results from the OUT1 sheet in one summary table. Do not use the reserved names 
IN1, OUT1, BAL and Target as sheet names. 

To add sheets select Insert Sheet from the menu. This will add one sheet on the selected 
location. To rename this new sheet, double click the Tab on the bottom of the form. You 
can also import Excel sheets by selecting Insert Excel Sheet from the menu. This 
selection allows you first to select the file and then the sheet which you want to insert into 
the active Heat Balance workbook. 

The example in Fig. 7 shows a FEED sheet, which is used to specify the raw materials 
amounts to the IN1 sheet. The user may give the compositions and amounts in column C, 
this data will then be used to calculate the amounts of species in column F. The material 
amounts in IN1 sheet are given using relevant cell references to column F in the FEED 
sheet. This example can be found from your HSC5\Balance directory under the name 
CUCONV2.BAL. The user can construct the layout of the additional sheets freely. 

The “Red Font Shield”property is a useful way to prevent accidental modification of the 
data in the cells. If this property is set using menu selection Format, Red Font Shield 
then only cells with red font can be edited. However, it is recommended to save the work 
regularly using different names, for example, test1.bal, test2.bal, test3.bal, etc. in order to 
recover the original situation after harmful modifications. 
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Fig. 7. Additional sheets can be added to the Heat Balance workbook. 
 

11.7 Target Dialog 
The user can iterate manually, for example, the fuel amount which is needed to achieve 
zero heat balance by changing the fuel amount until the heat balance is zero. The Target 
sheet offers a faster automatic way to carry out these kind of iterations. The following 
instructions will explain this procedure in more detail: 
1. Select Target Dialog from the menu. This will also automatically create a Target 

sheet, which is similar to previous HSC versions. 
2. Select one cell on row 4 in the Target dialog if not selected. 
3. Select one cell which will be used as a first variable and select Set variable cell. 

This will add the cell reference of this variable to the Target dialog in column B. 
You can also type the cell references manually in the Target dialog. Note: Please 
use only Stream temperature cells as variables for the temperature iterations, ie. do 
not use species temperature cells. 

4. Select one cell which will be used as first variable and select Set target cell. This 
will add the cell reference of this variable to the Target dialog in column B.  

5. Repeat steps 3 and 4 if you want to add more variables and targets. 
6. Set valid Min and Max limits in columns D and E as well as the Target Value in 

column H. You may also type names in columns A and F. 
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7. Usually it is also necessary to give estimated initial Test Values in column C for 
the automatic iterations. Iteration ends when the target value (col H) or iteration 
number (col I) is reached. Accuracy can be improved by increasing the number of 
decimals used in columns G and H with the Format Number selection. 

8. Select the rows (> 3) on the Target sheet which you want to iterate and press 
Iterate selected rows or F8. If all rows should be iterated, simply press Iterate 
All.  

In the following example, shown in Fig. 8, you can select for example row 4 and press 
F8. This will evaluate the copper scrap amount which is needed to maintain the heat 
balance in the given conditions. Row 5 can be used to iterate the iron content of the matte 
in the same conditions and row 6 to achieve a given FeS amount. 

Important note: Please use only Stream temperature cells as variables for the temperature 
iterations, ie. do not use species temperature cells. 

 
Fig. 8. Target dialog specifies the variables and target cell references. 
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11.8 Graphics 
 

Occasionally it is useful to see the results, of for example a heat balance calculation, in 
graphical format. This can be carried out manually by making step by step changes to one 
variable cell and collecting data from interesting cells, for example, to an Excel sheet. 
Sometimes further calculations may be required after every step, which can be specified 
using the Diagram Dialog. Step by step the procedure is as follows: 
1. Select Diagram/Diagram Dialog from the menu. 
2. Select the variable cell and press Set X-cell from the dialog. Select, for example, 

cell C11, see Fig. 7. 
3. Select a cell for the y-axis and press Set Y-cell from the dialog. Select, for 

example, the Heat Balance cell at the bottom right of the form. You may repeat this 
step and collect several cells whose values will be drawn to the diagram. 

4. If other calculations are required between every step, press Target iteration and 
the Target sheet will automatically open. Select the calculation rows that should be 
iterated before the Y-row and press Set Target rows from the menu. The row data 
will now be tranferred to the Diagram dialog into columns 4, 5, etc. 

5. Fill the Diagram Settings as shown in Fig. 9. You must specify the MIN, MAX and 
STEP values for the X-Axis. You can also specify the cell references, labels and 
units manually in this form. 

6. Press Diagram to create the tabular data for the diagram and Diagram once again 
to see the final diagram, Fig 9. 

7. The diagram can be modified, copied and printed in the same manner as other 
diagrams in HSC Chemistry.  

8. Show/Toolbar shows the drawing menu and Show/Object Editor shows the 
object editor, which lets you specify the objects manually. 

9. To return to the Heat Balance module, press Exit at the bottom left corner of the 
diagram form. 

From the diagram shown in Fig. 9 you can see that roughly 68 kg/h of scrap is needed to 
adjust the heat balance to zero. Notice that the units in the diagram are kg/h and kW. 
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Fig. 9. Simple heat balance diagram. 
 
  In the following diagram (Fig. 10) the heat balance is automatically calculated before 

each step, which is indicated by the number “4” in the Target row 1 column. This is done 
by pressing the Target iteration button, selecting row 4 on the Target sheet and clicking 
the Set Target rows button. The x-axis now gives the Fe wt-% and the y-axis the cooling 
scrap required. The diagram may then be interpreted as the quantity of cooling scrap 
required to make the heat balance zero, when the Fe wt-% varies from 20% to 25%.    
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Fig. 10. Diagram where the heat balance is automatically iterated to zero before every calculation step. 

 

 

11.9  Multiple balance areas 
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The previous Balance modules up to HSC 4.0 were restricted to one balance area (or 
control volume) only. Since most processes consist of multiple balance areas, the new 
Balance module enables the user to create up to 127 multiple balance areas. A balance 
area consists of an INx and an OUTx sheet, where x denotes the number of the balance 
area. These can then be connected to each other creating a realistic simulation of a 
process. The example file FSF_process.BAL contains a highly simplified multibalance 
model of an Outokumpu Flash Smelting Furnace process.  

A new balance area is created by selecting either Insert/Balance Area to Right or 
Insert/Balance Area to Left from the menu. This will insert a pair of INx and OUTx 
sheets to the corresponding position. A balance area may easily be deleted by selecting 
Delete/Balance Area. Deleting a single sheet of a balance area, for example an INx 
sheet, is not possible. The balances are all automatically collected into the BAL sheet so 
please do not modify this sheet. 

 

Fig. 11. The BAL sheet when the worksheet consists of 5 balance areas. 

Linking the balance areas with each other is recommended to carry out after each 
individual balance areas operate properly. Linking may be achieved either manually 
with formulae or automatically with the Copy - Paste Stream combination. Simply place 
the cursor on a stream row in an OUTx sheet, or on a row that belongs to a stream, and 
select Edit/Copy. Then place the cursor on a row in an INx sheet and select Edit/Paste 
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Stream. The stream will now be copied here so that the first row of the stream is the 
cursor position. The kmol column of the pasted stream will consist of links (formulae) to 
the copied stream, so that the material amounts of the streams will remain equal. The 
other cells are directly copied as values. If the stream temperature cell in the copied 
stream is a formulae then it will not be copied. In this case it is up to the user to decide 
how the stream temperature for the pasted stream should be calculated.  

It is also possible to create return streams, i.e. streams that return to a previous part of the 
process, thus creating loops in the process. When pasting a stream into an already linked 
part, a circular reference might occur. This is the case when links eventually refer back to 
each other, i.e. iterations are needed to calculate the worksheet. Automatic iterations may 
be done by selecting Format/Options from the menu and highlighting the Iteration 
checkbox under the Calculation tab. Please be careful when changing the inputs of a 
worksheet consisting of circular references. For example if a cell, which is part of a 
circular reference, shows the message #VALUE!, it will not recover unless the links in 
the cells are changed thus breaking the circular reference. Saving the worksheet regularly 
using different names (Test1, Test2, etc.) is thus always recommended.  
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Fig. 12. The IN1 sheet (Flash Furnace) of the FSF_process.BAL example. The stream Flue dust is a 
return stream from the boiler (Copy/Paste stream), thus creating circular references in the worksheet. 

Automatically updated defined names (input and output kmol amounts) vary according to the 
balance area. For example InAl, InC, OutFe for the first balance area will become InAl2, 
InC2, OutFe2 for the second etc. Note that the defined names of the first balance area do not 
have index numbers. 

 

Fig. 13. The OUT2 sheet (Converter I), gives the output from the first part of the converter. The formula 
=InCa2*Analysis!L29/100 in cell C5 means that the total Ca is distributed as the percentage given in cell 
L29 on the Analysis sheet. 
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Drawing Flowsheets (Flowcharts) 

Additional sheets may be used to collect, for example, all the necessary input for the process 
into one sheet. They may also be used to collect calculated process parameters, for example 
the amount of Cu in a stream. Figure 14 shows the process layout for the Flash Smelting 
Furnace process. 

"Insert, Graphical Object, ..." selection gives possibility to draw lines, rectangles, etc. on the 
additional sheets. However, it is recommended to draw flowsheets using "Format, Border, ..." 
and "Format, Pattern, ..." selection because these properties are more compatible with Excel 
95, 97 and 2000. Arrows may be drawn using "Insert, Graphical Object, Arrow" selection.  

HSC graphical objects are compatible only with Excel 95. This means that if you want to get 
the graphical objects to Excel-files then you should save using "File, Save XLS 5 file, ..." 
dialog. 

 

Fig. 14. Process layout and input sheet for the Flash Smelting Furnace process. 
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Figure 15 provides a more detailed analysis of the process. The model is constructed so that 
the inputs are given as species analysis and the outputs are calculated. The elemental 
distributions are also inputs, in other words the user defines the wt-% for the elemental 
distributions into the given species and streams. This is achieved using the automatically 
defined names, for example InCa and InO2, and thus always keeping the elemental balance at 
zero. The model may then be used to balance the heat balances of the process, which enables 
the user to calculate one unknown parameter per balance area. The unknown parameters 
calculated in the FSF_process.BAL example are indicated by a light blue cell background. The 
calculated parameters may be changed using the Target Dialog option, which is described in 
further detail in chapter 8. Target Dialog. 

 

Fig. 15. Detailed analysis of the input and output streams and the elemental distributions into different 
species. The distributions are given in wt-% (weight percentage).
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11.10 General Considerations 

In the Heat Balance module it is possible to use the new add-in functions provided by 
HSC 5.0. The functions should be enabled automatically, this may be seen from the File 
selection in the menu. A checked HSC5.dll On indicates that the functions are available 
and a checked HSC5.dll Off indicates that they are disabled. Sometimes it is necessary to 
browse the location of the add-in file manually. This is done by selecting File/Add-Ins 
from the menu and then browsing to your Windows system directory (for example 
c:\Windows\System in Windows 98) by pressing the Browse... button. Select the file 
“HSC5.dll”. A more detailed description of the functions available may be found in 
Chapter 27. Excel Add-Ins. It is, however, not recommended to use add-in functions for 
very large worksheets, since a complete recalculation of the worksheet is necessary each 
time a change is made in the worksheet. This is the case only when using add-in 
functions. 

Please do not use temperature formulae that are linked to other temperature values within 
a stream, instead link them to the stream temperature cell or any cell in a user sheet. 
Otherwise the temperatures will be updated only after the next change. Notice also that a 
change in the temperature value is required for the whole stream to be updated 
accordingly. 

Simple graphical objects may be inserted by selecting Insert/Graphical Object from the 
menu. The shapes are: Line, Rectangle, Oval, Arc and Polygon. After inserting, the 
objects may be modified by first selecting the object and then selecting Format/Object 
from the menu.  

The Latent H column (= specific heat) is used to describe the energy which may be 
released when the compound is cooled down from the given temperature to 298.15 K. In 
other words, it contains latent heats (= enthalpies of the possible phase transformations) 
but also specific heats. The enthalpies given in the Total H column contain the values of 
the Latent H column as well as the heats of formation reactions. These values are used to 
calculate heat balances. 

In molten mixtures such as oxide slags, substances can exist in liquid state at lower 
temperatures than their melting points. In these cases it is possible to use an (l)-suffix at 
the end of the formulae, see Fig. 1. This will force HSC to use data of the liquid state for 
species with an (l)-suffix. 

The “Red Font Shield” property is sometimes useful if you want to prevent accidental 
changes to cells. You can activate this property by selecting Format Red Font Shield 
from the menu. After this selection you can edit only those cells which contain red font. 

If you have carried out a laboratory or industrial scale experiment or process calculations 
you usually know: 

1. The raw (input) materials and their amounts and temperatures. 
2. The product (output) materials and their amounts, temperatures and analysis. 
3. The input heat and heat losses can first be estimated as zero, if not available. 

In order to calculate a heat balance you must first convert the (elemental) chemical 
analysis of the raw materials and the products into input and output substances (species). 
Sometimes this step is the most difficult, so you may choose to carry out this procedure 
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using the HSC Mineralogy Iterations module, see Chapter 22. Mineralogy iterations. 
When this is completed, simply type the input substances (species) into the IN1 Sheet and 
the output substances into the OUT1 sheet. Immediately after that you will see the heat 
and material balance on the bottom line. You can also test the procedure described in 
chapter 5. 

It is important to check the element balance by selecting Calculate/Element Balance, in 
order to avoid incorrect material and heat balances. This can also be used to check the 
validity of the chemical analyses and the other amount measurements of the experiment if 
the user input is based on this data. 

When creating a multiple balance area model, selecting Calculate/Total Balance shows 
an overview of all balance areas in one window. This is useful for a quick check where 
the material and/or heat balance are not zero. It also shows the total (or net) material and 
heat balance for all balance areas. It is then easy to see which balance areas produce heat, 
which require heat, and indications of how the heat could be tranferred within the 
process.  

On the basis of the final results, conclusions can be made as to whether extra energy is 
needed or increased insulation is required or if the reactor needs cooling on a large scale. 
The heat losses may also be determined using the HeatLoss module. Combining the two 
modules provides a powerful way of calculating processes. 

It is important to note that this is a real heat balance for engineering purposes, which also 
takes into account the kinetic aspects if the user input is based on real experimental data. 
The heat balance, which can be obtained from the equilibrium calculations, is theoretical 
in this respect. It is valid only if the equilibrium is reached in the real process. 
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11.11 Heat Balance Examples 
 

See the examples provided by the HSC package by selecting File/Open from the menu, 
see Fig. 1, and select some of the ready made files in the directory for editing. HSC 5.0 
can read the old HSC 2.0 Heat Balance text-files, but it cannot save them in the old 
format. The new HSC 5.0 Heat Balance files save all the sheets and formats, not only the 
text data. 

 
1. Preliminary check for a heat balance (CUSMELT.BAL file) 

For some processes based on reaction equations or equilibrium calculations, the 
heat balance can easily be checked by entering the assumed input and output 
substances as well as their temperatures and amounts, see example CUCONV.OHE 
and CUSMELT.OHE, Fig. 1. 

 
2. Adiabatic temperature of the flame (BUTANE.BAL-file) 

In an adiabatic process heat losses from and heat input to the system are zero, i.e. 
there is no heat exchange with the surroundings through the system boundaries. 
Therefore, the adiabatic temperature equals the highest attainable temperature from 
a flame or a chemical reaction. By typing the raw materials into the IN1 sheet and 
the products into the OUT1 sheet it is possible to see the adiabatic temperature by 
selecting Calculate/Temperature Balance from the menu, Fig. 3, see example 
BUTANE.OHE. 

 
3. Dimensioning of an evaporator (H2O.BAL-file) 

The evaporator dimensions can be optimized manually by typing the input 
substances into the IN1 sheet and the desired output substances, amounts and 
temperatures into the OUT1 sheet. Once these have been entered, you can start to 
change the amount or temperature of the input vapor (input heat if heated by 
electricity) manually, in order to find the optimum values. See example H2O.OHE. 

 
4. Net and gross heat value of coal, fuel oil and natural gas. 

(Coal1-, Coal2-, FuelOil1-, FuelOil2-, NatGas1.bal-files) 

The Heat balance module makes it possible to calculate the Heat Values (Calorific 
Values) for different fuels. Examples for coal, fuel oil and natural gas are found in 
the example files. Notice that the chemical structures of the fuel oil and coal are 
very complicated, however, heat values based on the elemental analysis will 
usually give sufficiently accurate results for practical applications. 
 

5. Outokumpu Flash Smelting Furnace process  (FSF_process.BAL-file).  

This  highly simplified process case consist of five balance areas linked together. 
The balance areas are:  
1) Flash Smelting Furnace 
2) Converter I 

            3) Converter II 
.   4) Boiler 
   5) ESP 

The process input values are provided in the Process flow sheet and in the 
Analysis sheet. By pressing F8 or by selecting Iterate All from the Target Dialog, 
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the heat balances are calculated. The values calculated are in the Process flow 
sheet and indicated by a light blue cell background. 
 

6. Iron production process (Iron_process.BAL file).  

The example in this file is a very simplified model of an iron production process 
consisting of three balance areas: 
1) Pelletizing 
2) Coking 
3) Reduction 
The process and its most important parameters are shown in the Process flow 
sheet, with a more detailed analysis available in the Analysis sheet. Notice that 
only the material balances are zero and iterated according to what is set in the 
Target sheet (or Target dialog). The heat balances are not iterated and therefore not 
zero. 


